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Installing KNIME Analytics Platform

1. Go to the download page on the KNIME.com website to start installing KNIME Analytics

Platform.

2. The download page shows three tabs which can be opened individually:

◦ Register for Help and Updates: here you can optionally provide some personal

information and sign up to our mailing list to receive the latest KNIME news

◦ Download KNIME: this is where you can download the software

◦ Getting Started: this tab gives you information and links about what you can do

after you have installed KNIME Analytics Platform

3. Now open the Download KNIME tab and click the installation option that fits your

operating system. KNIME Analytics Platform can be installed on Windows, Linux, or

macOS.

Notes on the different options for Windows:

◦ The Windows installer extracts the compressed installation folder, adds an icon to

your desktop, and suggests suitable memory settings.

◦ The self-extracting archive simply creates a folder containing the KNIME

installation files. You don’t need any software to manage archiving.

◦ The zip archive can be downloaded, saved, and extracted in your preferred

location on a system to which you have full access rights.

Figure 1. KNIME Analytics Platform available installers

KNIME Analytics Platform Installation Guide

© 2024 KNIME AG. All rights reserved. 1

https://www.knime.com/downloads


4. Read and accept the privacy policy and terms and conditions. Then click Download.

5. Once downloaded, proceed with installing KNIME Analytics Platform:

◦ Windows: Run the downloaded installer or self-extracting archive. If you have

chosen to download the zip archive instead, unpack it to a location of your choice.

Run knime.exe to start KNIME Analytics Platform.



With KNIME Analytics Platform version 5.3 you have the possibility

to start KNIME Analytics Platform in high-resolution mode. To do so,

go to the installation folder and run knime-hidpi.bat. Please notice

that the batch file to start the KNIME Analytics Platform in the high-

resolution mode is an experimental feature designed exclusively for

Modern UI. This feature aims to enhance visual fidelity but is not yet

fully supported across the classic user interface and the Modern UI.

So, users should be aware of potential limitations and compatibility

issues when switching between Modern UI and Classic UI contexts.

◦ Linux: Extract the downloaded tarball to a location of your choice. Run the knime

executable to start KNIME Analytics Platform.

◦ Mac: Double click the downloaded dmg file and wait for the verification to finish.

Then move the KNIME icon to Applications. Double click the KNIME icon in the list

of applications to launch KNIME Analytics Platform.

The following operating systems versions are supported:

• Windows

◦ Windows 10, 11

◦ Windows Server - 2016, 2019, 2022,

• Ubuntu 20.04 LTS and 22.04 LTS and derivatives

• RHEL/CentOS/Rocky Linux 8, 9

• macOS (12 and above - macOS x86_64 Intel) and M1 (macOS arm64 - Apple silicon)

(only the last two major versions are supported)

◦ macOS 12: Monterey

◦ macOS 13: Ventura


Also check the KNIME Getting Started Guide and the KNIME Analytics Platform

User Guide.
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Configuration settings and knime.ini file

When installing KNIME Analytics Platform, configuration settings are set to their defaults,

and they can later be changed in the knime.ini file. The configuration settings, i.e. options

used by the Java Virtual Machine when KNIME Analytics Platform is launched, range from

memory settings to system properties required by some extensions.

You can find knime.ini in the installation folder of KNIME Analytics Platform.



On macOS: To locate knime.ini on macOS, open Finder and navigate to your

installed Applications. Next, right click the KNIME application, select Show

Package Contents in the menu, and navigate to Contents → Eclipse.

The knime.ini file can be edited with any plaintext editor, such as Notepad (Windows),

TextEdit (macOS) or gedit (Linux).

Allocating memory in knime.ini file

The entry -Xmx1024m in the knime.ini file specifies how much memory KNIME Analytics

Platform is allowed to use. The setting for this value will depend on how much memory is

available in your machine. KNIME recommends setting it to approximately one half of your

available memory, but you can modify the value based on your needs. For example, if your

computer has 16 GB of memory, you might set the entry to -Xmx8192m.
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Installing Extensions and Integrations

If you want to add capabilities to KNIME Analytics Platform, you can install extensions and

integrations. The available extensions range from free open source extensions and

integrations provided by KNIME to free extensions contributed by the community and

commercial extensions including novel technology nodes provided by our partners.

The KNIME extensions and integrations developed and maintained by KNIME contain deep

learning algorithms provided by Keras, high performance machine learning provided by H2O,

big data processing provided by Apache Spark, and scripting provided by Python and R, just

to mention a few.

Install extensions from:

• KNIME Hub:

◦ Search for the Extension or Integration you want to install in the search bar

◦ Click Extensions on the results page

◦ Click the extension you want to install, and from the extension page and drag and

drop the squared yellow icon, shown in Figure 2, to the KNIME Analytics Platform.

A window will open asking if you want to search and install the extension or

integration. Click Yes and follow the instructions.

Figure 2. Install the KNIME Integrated Deployment Extension from KNIME Hub

◦ Restart KNIME Analytics Platform.

• KNIME Analytics Platform:

◦ Go to the Menu in the top right corner of the KNIME Analytics Platform.

◦ Select Install Extensions. The dialog shown in Figure 3 opens.
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Figure 3. Installing Extensions and Integrations from KNIME Analytics Platform

◦ Select the extensions you want to install

◦ Click Next and follow the instructions

◦ Restart KNIME Analytics Platform.

The Install Extensions menu provides the extensions that are available via the update sites

you have enabled.



If you encounter issues during the installation of Python based extensions,

these might be related to challenges specific to this type of extensions. Find

here information about how to troubleshoot these issues.

To uninstall an extension, go to the Help menu in the top right corner of the user interface

and select the About KNIME Analytics Platform. In the window that opens click Installation

Details. A dialog shown in Figure 4 opens. Now, select the extension that you want to

uninstall, and click Uninstall….
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Figure 4. Uninstalling Extensions and Integrations
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Updating KNIME Analytics Platform and
Extensions

It is good to make sure that you always use the latest version of KNIME Analytics Platform

and its extensions.

To do so:

1. Go to the Menu in the top right corner of the KNIME Analytics Platform.

2. Select Check for updates. In the dialog that opens, select the available updates you

want to install and then click Next.

3. Proceed by following the instructions. KNIME Analytics Platform has to be restarted in

order to apply the updates.
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Update Sites

The Update Sites are where KNIME retrieves additional software in the form of extensions as

well as updates. To see or edit the available update sites, click Preferences in the top right

corner of the user interface. This opens the Preferences dialog. Select Install/Update →
Available Software Sites.

Default Update Sites

These four updates sites are provided by KNIME and are always available:

Figure 5. Available Update Sites

KNIME Analytics Platform 5.3 Update

Site: Provides all extensions and

integrations maintained by KNIME: R,

Python, H2O Machine Learning, Apache

Spark for big data, and many more.

Contains KNIME Labs Extensions, which

are extensions that are not yet part of the

set of stable KNIME extensions because

their functionality may not yet be

finalized.

Community Extensions (Experimental):

Provides additional extensions created by

the KNIME community.

KNIME Community Extensions (Trusted):

Provides trusted community extensions,

i.e. extensions created by the KNIME

community, which have been tested for

backward compatibility and compliance

with KNIME quality standards.

KNIME Partner Update Site 5.3: Provides

extensions created by KNIME partners.

KNIME Analytics Platform 5.3 Update Site and KNIME Community Extensions (Trusted) are
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enabled by default.

Adding External Update Sites

To install extensions that are not part of the above update sites, click Add to manually add

the relevant update site, inserting the Name and Location as shown in Figure 6.

Figure 6. Add Update Sites

After adding a new update site you will see it listed in the Available Software Sites. You must

now enable it by selecting it from the list.

Adding Local Update Sites

If your working environment has limited internet access or you receive an error message

“Proxy Authentication Required” when connecting to a remote update site (provided by a

URL), you can install extensions from a local zip file.
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1. Download KNIME update sites as zip files at the following links:

◦ KNIME Analytics Platform Update Site

◦ KNIME Community Extensions

◦ KNIME Partner Update Site 5.3

2. Save the zip file containing the extensions to your local system

3. Click Preferences in the top right corner of the user interface. This opens the

Preferences dialog. Select Install/Update → Available Software Sites and enter the path

to the zip file by clicking Add → Archive… as shown in Figure 7.

Figure 7. Adding Update Sites from Zip Archive


If the same extensions are provided by a URL, you will first have to disable

the update site by disabling it in the list.

4. Now click Apply and Close



If the same extensions are also provided by a remote update site, you will

first have to disable that update site by deselecting its entry in the

Available Software Sites dialog and confirming via Apply and Close.
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Working with the Nightly Builds

Once a night, a new version of KNIME Analytics Platform is created directly from our

development branch. The Nightly Build versions available here provide insight into what’s

coming up in the next regular release. However, for real work, always use a version of a

standard KNIME release. Also read the following disclaimer before proceeding:



Really, really, really important disclaimer

This is most definitely not production quality code. These nightly builds are

what we use internally to validate and test recent developments, so they are not

tested as thoroughly as standard KNIME releases. Furthermore new nodes or

functionality may change substantially (or disappear entirely) from one build to

the next. It’s even possible that workflows you edit or create with nightly builds

stop being readable by future (or past) versions…

These nightlies are a great way to get a sneak peek at what may be coming in

the next version of KNIME and provide feedback and suggestions. They are not

a particularly safe way to do real work.
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Release notes and changelogs (KNIME
Analytics Platform 5.3)

Release notes and detailed changelog for v5.3.x releases

KNIME Analytics Platform 5.3.3

Release date: November 06, 2024

Changelog (KNIME Analytics Platform 5.3.3)

Enhancements

• AP-23228: Implement force refresh for invalid OAuth access tokens in the REST nodes

• AP-23227: Support refresh of registered secret types e.g. Databricks and Salesforce

• BD-1316: Adapt Databricks Workspace Connector to support new Databricks specific

credentials port

• AP-23380: (Internal API:) Intended breaking point to reduce impact of possible memory

leaks in 3rd party extensions

• AP-23356: Make Google Sheets Reader more robust by retrying failing requests

• AP-23346: Make SharePoint List Writer more robust by retrying failing requests

• AP-23213: Write executor container logs to configurable file

• AP-23195: AI Extension: Support GGUF version of IBM Granite in GPT4All

• AP-23190: AI Extension: Support Microsoft Phi 3.5 in GPT4All nodes

• AP-23089: Harmonize wording in OAuth node dialogs with Hub UI for corresponding

secrets

• BD-1317: Support Databricks secrets in Secrets Retriever node

• NXT-2978: Update Equo Chromium to 116.0.22

Bug Fixes

• AP-23371 Excel Reader cannot read file when internal files are more than 1000 (kudos

to @Kazimierz for reporting 1)
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• AP-23362 Python Extensions in 5.3.2 do not require knime-core 5.3.2 and then fail

because of a missing watchdog (kudos to @erikawalther for reporting 1)

• AP-23267 Directories on SMB network share erroneously detected as non-writable

(kudos to @cridiaz for reporting 1)

• AP-23194 Importing WF from AP ⇐ 5.0 to AP 5.1, 5.2 or 5.3 with a string replacer

causes parameters to not appear (kudos to @tymsk3891 for reporting 1)

• AP-23036 Excel Writer writes unnecessary metadata which is flagged as sensitive by

PowerBI (kudos to @ReWi for reporting 1)

• AP-22836 Excel Writer dialog shows warning when adding a space to a sheet name but

still executes fine (kudos to @Christopher41 for reporting 1)

• UIEXT-2190 DynamicValuesInput with flow variables prevents dialog from closing when

switching columns (kudos to @richards99 for reporting 1)

• AP-23438: Generic ECharts node: DefaultZonedDateTimeReadValue cannot be cast to

class StringValue

• AP-23424: Errors in console when logging into EXAMPLES in classic UI

• AP-23361: Conda Env Propagation node deletes ALL envs if env name flow variable is

blank

• AP-23353: Row Filter uses numeric input widget for Row number matching (wildcard,

regex) instead of string input

• AP-23315: Expression capitalize function keeps all caps inputs untouched

• AP-23304: Expression: Non-understandable error message when replacing a column

that does not exist

• AP-23264: Splash screen image is flipped on macOS >=15 (caused by Eclipse 2024-03

workaround)

• AP-23216: Workflow Reader node: Workflow Choosers fetches only 10 versions (should

be much higher)

• AP-23171: Insertion of Linked Component into Component with Executing Downstream

Nodes Corrupts Workflow

• AP-23094: String representation of types known to Python shows internal types

• AP-23093: InvalidParametersError shows class name in error message

• AP-23071: Deadlock in node repository initializer

• AP-23051: Generic ECharts Editor logs "Error: undefined" if no input data is available

• AP-22985: Python extension updates sometimes fail on windows with "Access denied"

error
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• AP-21796: Table Validator can throw ArrayOutOfBoundsException in configure when

input table did change

• AP-19656: String Manipulation logic breaks if KNIME open too long (temp files deleted

by OS)

• AP-10222: Attempted to append to closed appender while logging

• BD-1320: Remove warning message in HadoopInitializer

• BD-1315: Parquet Writer fails with "Unable to close resource" error

• UIEXT-2065: Report Page Sizing Broken

• UIEXT-2058: Deadlock on data point selection via data app

• UIEXT-2054: Image generation in executor (Hub/Server) may crash application under

heavy load (used in data viz nodes w/ image port enabled)

• UIEXT-1897: Scatter Plot with nominal color scale may plot incorrect data

• UIEXT-1792: Display additional warning in layout editor for views/widgets not present in

layout

KNIME Analytics Platform 5.3.2

Release date: September 11, 2024

Release notes

KNIME Analytics Platform version 5.3.2 is recommended for use in production environments.

Please refer to the 5.3.0 release notes for additional information about updates with respect

to the previous version 5.2.x.

• Udpate 5.3.0 → 5.3.2: The Variable Filter node was updated to only filter “local” (scope

variables).

Changelog (KNIME Analytics Platform 5.3.2)

New nodes

• AP-23108: AI Extension: Vector Store Data Extractor (kudos to @longoka for reporting

1)

• AP-22977: KNIME Hub AI Model Lister
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• AP-22956: Giskard RAGET Evaluator

• AP-22953: Giskard RAGET Test Set Generator

• AP-22887: Giskard LLM Scanner

Enhancements

• AP-22349: Allow to specify collection name in Chroma Vector Store Creator (kudos to

@TosinLitics for reporting 1)

• AP-22350: Allow to specify collection name in Chroma Vector Store Reader (kudos to

@TosinLitics for reporting 1)

• AP-22915: Row Filter to support "matches regex/wildcard" for all string-compatible

types and integral numbers (kudos to @KunalB86, @mwiegand for reporting 1, 2)

• AP-23109: AI Extension: Support pre-calculated embeddings in vector store creators

(kudos to @longoka for reporting 1)

• NXT-2415: Show progress during update check and installing or updating extensions

(kudos to @mwiegand for reporting 1)

• AP-23208: Component updates/Classic UI: List which components have updates in the

update dialog

• AP-23160: Respect direct memory setting in Watchdog

• AP-23158: Report KNIME process usage in executor logs

• AP-23079: Row Filter should support all data types with missing/not missing operators

• AP-23029: Core Data API: Make BufferedRowContainer#setFrom faster when RowRead

and RowWrite are both "buffered "

• AP-23018: Do not perform host exclusion in GlobalProxySearch

• AP-22969: Extend executor start script to forward executor crash information to stdout

• AP-22951: Allow Conda processes to be terminated by Watchdog

• AP-22950: Allow Python processes to be killed by watchdog

• AP-22948: Add watchdog to AP that kills external processes' that use too much

memory

• AP-22937: Determine executor heap size based on container requests

• AP-22789: Rename filter operators in new Row Filter node

• AP-22578: Add NodeFunc for Expression node

• NXT-2824: Update Equo Chromium to latest 116.0.17
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Bug Fixes

• AP-23128: Row Filter dialog logs exception when switching from null-valued String to

non-String input (kudos to @mwiegand for reporting 1)

• AP-23134: Switch to modern UI freezes frontend due to uncaught class cast exception

(kudos to @swebb for reporting 1)

• NXT-2764: CallThrottle throws "RejectedExecutionException" in "hybrid mode" (kudos to

@mwiegand for reporting 1)

• UIEXT-2075: Crashes with Modern Dialogs on Linux when using Remote Desktop

Protocol (kudos to @umutcankurt for reporting 1)

• AP-22911: Excel Writer suddenly complains about record length (kudos to @Kazimierz

for reporting 1)

• AP-23008: Installed AP on Windows doesn’t start without installing a JRE if Windows

UTF-8 (locale) was enabled before AP installation (kudos to @ssimara for reporting 1)

• AP-23021: Excel Writer produces files which PowerBI claims are corrupt, but which

open normal in Excel (kudos to @vstefano for reporting 1)

• AP-23292: Cancelling upload to public space doesn’t work in MUI

• UIEXT-2138: File Upload Widget: Selecting larger (30+MB) file causes view save to fail

• UIEXT-2124: Image and report generation doesn’t work in (batch-)executor on Windows

• UIEXT-2096: Nominal value row filter widget: invalid values prevent execution

• UIEXT-2087: Clicking on download link of File Download Widget makes the view black

(node or composite) if the file is a PDF

• UIEXT-2070: Changing Column Width in the Table View is not reflected in the pdf report

• AP-23175: Variable Filter: Merged filtered stacks are unexpected - reducing node

functionality to filter "scope variables only "

• AP-23166: If function accepts non boolean values as elseif conditions

• AP-23165: Switch function does not accept MISSING as the first case

• AP-23137: REST nodes use AP-wide proxy authentication even though disabled in node

• AP-23097: Giskard report displays non-breaking whitespaces incorrectly on Windows

• AP-23059: SMB Connector fails with NullPointerException if password in credentials

flow variable is null

• AP-23058: Salesforce Connector should treat security token as an optional field

• AP-23041: Expression: summary of parse_int says it creates float

• AP-23016: Call Workflow Service gives unhelpful error message if API returns invalid
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data in Dialog

• AP-22940: Python doesn’t trust same CA’s as the rest of the AP

• AP-22873: NPE in Expression node after column rearranging without appending

• AP-22807: Python-based nodes with optional ports allow to connect more than one port

• AP-22707: Text Embedder fails on table without rows

• UIEXT-2118: Memory Leak in Table View (ModernUI) keeps reference to workflow

instance

KNIME Analytics Platform 5.3.1

Release date: August 07, 2024

Changelog (KNIME Analytics Platform 5.3.1)

Enhancements

• AP-22962: Add GPT-4o Mini in OpenAI Chat Model Connector

• AP-22917: Support parallel calls in KNIME Hub Chat Models

• AP-22842: Workflow Reader to show Version Selector field unconditionally

• NXT-2788: Update Equo Chromium to 116.0.14

Bug Fixes

• AP-22279: Feature selection loop passes all columns in all iterations after a failed

execution of the loop construct (kudos to @richards99 for reporting 1)

• AP-22864: Webpage Retriever fails for some webpages (kudos to @jrauhamaki for

reporting 1)

• AP-23030: Get Request node - Unable to edit the "Delay (ms)" option (kudos to

@ricardo_martins for reporting 1)

• UIEXT-1896: Column renamer sometimes does not rename (kudos to @Tigerfox for

reporting 1)

• AP-22876: Potential deadlock when initializing variable types during startup (kudos to

@mwiegand for reporting 1)

• AP-22906: High CPU load when connecting to Hub without execution contexts (kudos

to @mwiegand for reporting 1)
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• NXT-2747: Node views (and dialogs with node view pre-views) are blank when starting

AP with classic UI (kudos to @gawright63, @mwiegand, @alfroc for reporting 1, 2, 3, 4)

• AP-22925: Azure Embeddings serialize crashing because of 'missing _dimensions'

• AP-22924: Excel Reader dialog can enter inconsistent state when no password is

provided for protected files

• AP-22909: Freeze when trying to open a workflow in Remote Workflow Editor

• AP-22903: FAISS vector store reader fails due to pickle deserialization

• NXT-2833: Composite views are blank when starting with classic UI

• UIEXT-2068: RowID node fails if replace option contains missing value although

unchecked

• UIEXT-2062: Refresh button looses label and button text when opening in 5.3

• AP-23044: REST nodes fail on sequence of different row-length returning requests

• AP-23003: Row Filter is missing "is not missing" operator

• AP-22929: Buggy 3rd party extension can prevent workflow execution on KNIME Hub

• AP-22914: Row Filter criterion widget has inconvenient update behavior (resets too

much, offers non-ideal choices)

• AP-22901: Columnar container tables cannot be saved in NodeModel#saveInternals(…)

(Problems in, e.g. Entropy Scorer node)

• AP-22898: Row Filter validation is too strict for Adapter Cells, e.g. Smiles

• AP-22886: ROW_ID, ROW_INDEX and ROW_NUMBER missing in expression

autocompletion

• AP-22870: Instrumentation: Fix apusage and hubusage

• AP-22834: Error in COLUMN_STDDEV return type documentation

• AP-22833: COLUMN_STDDEV can only have one optional argument at a time

• AP-22832: Inconsistent formatting of aggregation return types compared to return

types of functions

• AP-22762: Initial Value of replacement column is not set

• AP-22551: Workflow credential "knime.system.default" is treated by mistake as flow

variable and fails with IllegalFlowVariableNameException

• AP-19687: Table Manipulator: Unable To Include Columns On Changing Table Spec

• UIEXT-2058: Deadlock on data point selection via data app
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KNIME Analytics Platform 5.3.0

Release date: July 10, 2024

Release notes

Updates and compatibility

• In-app upgrades from KNIME Analytics Platform 5.2 are supported

• KNIME Analytics Platform 5.3 allows switching between Modern UI and the Classic UI

without having to close and reopen workflows. In future versions, this will change in

order to reduce technical complexity and pave the way for further enhancements of the

Modern UI

• Requirements:

◦ KNIME Analytics Platform 5.3 requires KNIME Hub 1.9 or newer

◦ KNIME Analytics Platform 5.3 must not be used as executor on KNIME Server

4.16.x or before. KNIME Server 4.17 with full compatibility will be released soon.

• Compatibility:

◦ The “Excel Reader” node might produce slightly different results when processing

special xlsx files with array formulas and the re-evaluate formulas option

checked. In KNIME Analytics Platform 5.2 certain formulas would evaluate to

missing cells and now evaluate to “0”, like in Excel

◦ Text Processing: The “Tika Parser” node might produce slightly different results

when processing documents with inline images. The reason is an update of the

underlying Apache Tika library from version 1.26.0 to 2.9.1

◦ Hadoop 3.x upgrade might require updating the Hadoop settings within KNIME

Analytics Platform

◦ Workflows running on Spark 3.3 and earlier require installation of the new

Sparkling Water legacy plugin

◦ Eclipse Birt was updated to the most recent version (4.15), which might scale

images differently if scaling is defined in %. See the Eclipse Birt ticket description

for details.

• End-of-life:

◦ Sparkling Water with Spark 3.4 and later will no longer be supported

◦ Existing workflows running on Spark 3.3 and earlier require the new Sparkling

Water legacy extension
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◦ Hive 2 and earlier will no longer be supported out of the box, users must register

their own driver

• Updates:

◦ Eclipse 2024-03 (underlying framework), to be "up to date" and to address known

CVEs

◦ Many third-party library updates (for more information see Preview of KNIME

Analytics Platform 5.3.0)

◦ Spark 3.5 support

◦ Hadoop 3.x support

◦ MongoDB driver updated to 5.1.1 to support latest MongoDB versions

◦ Hive driver updated to 3.x to support latest version

◦ Update of various built-in drivers and flagging of no longer supported DB drivers

For node developers only: (API) Interface definitions for datetime related types were moved

to a more central place (org.knime.core), e.g.

org.knime.core.data.time.localdate.LocalDateValue.

Known Issues

• Reporting:

◦ Fonts of reports might be incorrect if a component that produces a report has

been saved in an executed state before updating to 5.3. Re-executing the

component will solve the problem.

Changelog (KNIME Analytics Platform 5.3.0)

New nodes

• AP-16515: Filter flow variable(s) (kudos to @rolandnemeth @berti093 @darbon for

reporting 1 2 3)

• AP-21746: Email Sender (rewrite of old node, includes ability to inline KNIME reports in

HTML) (kudos to @beginner @cppong for reporting 1 2)

• AP-22415: Text Chunker (kudos to @TosinLitics for reporting 1)

• AP-22861: Google Ads Geo Targets

• AP-22829: Row Filter and Row Splitter (rewrite, with modern dialog and additional filter

functionality)
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• AP-22644: KNIME Hub Embeddings Connector

• AP-22289: OpenAI Fine-Tuned Model Deleter

• AP-22281: Presidio Analyzer

• AP-22104: Google Ads Keyword Ideas

• AP-22038: Giskard Scanner

• AP-21860: Expressions with modern Script Editor

• AP-21835: OpenAI Chat Model Fine-Tuner

• AP-21821: HF TEI Embeddings Connector

• AP-21793: KNIME Hub Chat Model Connector

• AP-21737: Credentials Property Extractor

• AP-21695: Salesforce Connector

• AP-21025: Google Ads Query

• AP-21021: Google Ads Connector

• BD-1290: (Big Data Extensions): Databricks Workspace Connector

• BD-1275: (Big Data Extensions): Databricks Unity File System Connector

• UIEXT-1818: Example Data Reader

Enhancements

• AP-15669: "Send to Tableau Server " node to support credentials variable (currently

requires user+pass in dialog) (kudos to @KristianRohde for reporting 1)

• AP-21747: Add Request Body to DELETE Request node (kudos to

@SharafutdinovRuslan @Gem for reporting 1 2)

• AP-22461: Columnar Backend: Improve Json cell handling by avoiding unnecessary

(un)marshalling (kudos to @mwiegand for reporting 1)

• NXT-1102: Handle little space for workflow breadcrumb (kudos to @mlauber71 for

reporting 1)

• NXT-2535: User interface scale (kudos to @Gentleman0758 for reporting 1)

• NXT-2633: Edit layout of linked component project (kudos to @rrousselot for reporting

1)

• UIEXT-1642: Web UI for String Splitter (Regex) (aka Regex Split) and support for named

capture groups (kudos to @mwiegand for reporting 1)

• AP-22692: Support path variables as JDBC parameters
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• AP-22682: Omit (confusing) warning about PMML incompatibility in Missing Value

node

• AP-22677: No longer prompt for "hard restart " after knime.ini changes (no longer

needed)

• AP-22669: Build python metapackages for 5.3 and update all python-based extensions

to use them

• AP-22665: Pass both, HTTP and HTTPs Proxy information to Python processes if they

differ.

• AP-22632: Skip unneeded duplicate checking at end of node execution (speedup at

nodes such as Row Filter/Splitter, Sorter, GroupBy, File Reader etc)

• AP-22629: Enable Async Hub Uploads/Downloads in Modern UI

• AP-22582: Update AWS SDK libraries to version 2.25.61

• AP-22557: Internal API: New 'DataContainerSettings' to avoid expensive duplicate

checking at end of node execution

• AP-22554: Add Python node dialog rule that can depend on the DialogCreationContext

• AP-22553: Option to use Presidio Analyzer output in Presidio Anonymizer

• AP-22538: (Programming API) New node description schema version supporting

modern markup

• AP-22525: Document Python Extension installation proxy settings

• AP-22508: Only poll for job updates if team has execution enabled on Hub

• AP-22491: K-AI keyboard navigation

• AP-22429: Programming API: Enable per-workflow logs with dedicated filter levels

detached from "logfile " filter in NodeLogger

• AP-22424: Workflow Reader to support Item Versions

• AP-22409: Enable user feedback in K-AI

• AP-22396: Deprecate Salesforce Authentication Extractor node

• AP-22382: Filter hubs K-AI can connect to via customization profile

• AP-22346: Add link from Python-based extension descriptions to installation

troubleshooting docs

• AP-22255: KNIME AP customization to filter node repository - node white/black listing

via hub delivered customization profiles

• AP-22253: HTML Column Expressions, String Formatter: Make clickable links open in a

new tab
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• AP-22251: Update H2 JDBC driver to version 2.2.224

• AP-22202: Update Node Icons to HighRes version

• AP-22191: Update SQLite JDBC driver to version 3.45.2.0

• AP-22190: Update PostgreSQL JDBC driver to version 42.7.3

• AP-22186: Update Redshift JDBC driver to version 2.1.0.26

• AP-22185: Deprecate several outdated JDBC drivers for H2, MySQL, Postgres, Redshift,

Snowflake, SQLite, and SQL Server

• AP-22168: Remove KNIME Server EJB support

• AP-22167: Text Processing: Update Apache Tika from 1.26 to 2.9 (used in nodes such

as "Tika Parser ")

• AP-22109: Row Aggregator and Value Lookup optionally support Hiliting

• AP-22081: Alignment suggestion for Format Manager nodes

• AP-22037: Python: Add schema_provider for ColumnFilterParameter and

ColumnParameter

• AP-21983: Include knime-extension-bundling version (git hash?) in bundled extensions

and pipe it into create_env.out for easier troubleshooting

• AP-21977: Hide script editor side and bottom panels if editor size is too small

• AP-21959: Value switch for model selection mode in OpenAI Connectors

• AP-21940: Python nodes: different connections port objects give incomprehensible

error

• AP-21931: Lower runtime of LLM Prompter via async calls

• AP-21924: Update models in OpenAI Connectors

• AP-21909: Local file browser for GPT4All nodes

• AP-21888: Improve URL handling in REST client nodes

• AP-21875: Rework HeapCache in Columnar Backend (aka HeapBadger)

• AP-21856: Support hiding Python-based nodes

• AP-21811: knime-ext-bundling: remove KNIME version selector from scripts

• AP-21797: H2O Integration: Add H2O version 3.46.0.x

• AP-21790: New KNIME Hub mountpoint option in KNIME Hub Authenticator

• AP-21786: Use URLConnection instead of HttpClient for REST requests (improves

stability for concurrent requests)

• AP-21774: Keywords for AI Extension nodes
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• AP-21773: Support keywords for Python Node extensions

• AP-21748: Add Legacy/Deprecated labels to the extension names

• AP-21713: Add Python-node unit testing capabilities

• AP-21667: Support protected Hugging Face Inference Endpoints

• AP-21599: Support random seeds for LLMs

• AP-21579: Add configuration option for 'receiveTimeout' in Salesforce Query nodes

• AP-21550: Add option to KNIME Hub Authenticator to expose URL of current KNIME

Hub as flow variable

• AP-21335: Option to output similarity score in Vector Store Retriever

• AP-21269: Update of underlying Eclipse version from 2023-03 to 2024-03

• AP-20990: Fix security issues on parent-iframe communication in Generic ECharts View

• AP-20735: Extract Context Properties: provide additional fields

• AP-20367: Call Workflow Service node: List shared deployments

• AP-19971: Improve performance of the Parallel Chunk Loop with the Columnar Backend

• AP-19943: Append/Replace Option for String to Path Node

• AP-19911: Extract Column Header to Support Streaming

• AP-19137: Python Nodes: Allow a node to define dynamic ports

• AP-18499: Update MongoDB library to version 5.1.1

• BD-1311: (Big Data Extensions): Mark Sparkling Water nodes as legacy (Sparkling

Water support will be discontinued)

• BD-1300: (Big Data Extensions): Deprecate built-in JDBC driver for Impala

• BD-1299: (Big Data Extensions): Support unity file system in DB Loader for Databricks

• BD-1283: (Big Data Extensions): Add support for Apache Spark 3.5

• BD-1274: (Big Data Extensions): Update built-in JDBC driver for Apache Hive to version

3.1.3 (no longer supports connection to HiveServer 2 and earlier)

• BD-1272: (Big Data Extensions): Deprecate Sparkling Water for Apache Spark version

3.3 and earlier (moved to legacy extension)

• BD-1271: (Big Data Extensions): Update Create Local Big Data Environment to Apache

Spark 3.5

• BD-1269: (Big Data Extensions): Update Apache Parquet to version 1.12.2 and ORC to

version 1.4.4

• BD-1268: (Big Data Extensions): Update Hadoop libraries to version 3.4.1 (Depending

on your environment this might require changes in the KNIME AP Hadoop settings
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page)

• BD-1267: (Big Data Extensions): Deprecate no longer maintained Apache Spark

versions 3.2 and earlier (moved to legacy extension)

• BD-1262: (Big Data Extensions): Support H2O Sparkling Water with Apache Spark 3.5

(only local Spark)

• BD-1260: (Big Data Extensions): Add H2O Spark MOJO support for Apache Spark 3.4

• NXT-2725: Update Equo Chromium to 116.0.13

• NXT-2671: Dynamic home content tile

• NXT-2664: Create, open, edit locked components inside workflows

• NXT-2625: Highlight message in Workflow monitor when nodes with problem are

selected

• NXT-2588: Apply UI scaling factor to all detached browser windows

• NXT-2585: Create new private Hub space

• NXT-2582: Add Ctrl+Space to trigger quick nodes adding panel

• NXT-2553: Keyboard navigation support for node repository

• NXT-2543: Make project and sidebar tabs accessible via keyboard

• NXT-2533: Add setting to port view to "Show only selected rows"

• NXT-2530: Open context menu on the currently selected item(s) via a shortcut in

workflow canvas

• NXT-2448: Add "workflow configuration" to workflow description

• NXT-2447: Select space items after import

• NXT-2395: Change default size of workflow annotations

• NXT-2320: Restructure home page

• NXT-2266: Display full space item name in title

• NXT-2248: Custom link entries in Help menu

• NXT-2034: Allow right click for empty workflows to show context menu

• NXT-1534: Keyboard navigation support for space explorer

• NXT-1296: Create new workflow in current space level via plus icon in app header

• NXT-953: Change target of links e.g. in node description, workflow and component

meta information to be target= "_blank "

• NXT-389: Use arrow keys to navigate from one to another element inside the workflow

editor and move the selected element
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• UIEXT-1667: Web UI for Chunk Loop Start

• UIEXT-1644: Web UI for Value Counter

• UIEXT-1634: Web UI for Column Combiner

• UIEXT-1631: Web UI for Missing Value Column Filter

• UIEXT-1629: Web UI for Group Loop Start

• UIEXT-1628: Web UI for Date&Time Part Extractor (aka Extract Date&Time Fields)

• UIEXT-1328: Axis labels should default to selected column if not defined otherwise

• NXT-1461: Recent workflows and components in Home tab (kudos to @ArjenEX for

reporting 1)

• NXT-2195: Display errors and warnings in the Workflow monitor panel (kudos to

@rfeigel @Jerry @Schroedinger @takbb @iCFO @DiaAzul for reporting 1 2 3 4 5 6)

• NXT-2297: Reveal and select active project in space explorer via workflow or

component tab context menu (kudos to @mlauber71 for reporting 1)

• NXT-2394: Add keyboard shortcut(s) to open port view and detach active port view or

inactive port views (kudos to @stefanomosca for reporting 1)

• NXT-508: Connect nodes via shortcuts (kudos to @Christian_Essen for reporting 1)

• NXT-2675: Filter functionality for shortcuts with a search input

• NXT-2666: Filter current space explorer level with a search input

• NXT-2615: Click-away handling for workflow and component description changes

• NXT-2602: Access dynamic port actions with shortcuts

• NXT-2554: Disconnect nodes via a shortcut

• NXT-2392: Edit annotation with shortcut

• NXT-2374: Select multiple elements via shortcuts

• NXT-2042: Enable selection for embedded port and node views

• NXT-1880: Rich text metadata editing for components and workflows

• NXT-1867: Fill suggestions in quick nodes panel using most commonly used nodes

with compatible port type

• NXT-1786: Keyboard shortcut overview

• UIEXT-1864: Enable keyboard navigation in table selection

• UIEXT-1834: Introduce max row setting for Bar Chart in case of no aggregation

• UIEXT-1810: Rework dialog elements to be smaller for node dialogs

• UIEXT-1702: Sanitization of widgets leads to escaped rendered characters in certain
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cases

• UIEXT-1568: Enable horizontal virtual scrolling in table

• AP-22627: Deprecate nodes correctly that only have "(deprecated) " in their name

• AP-22585: Python framework: Raise an error if the table contains a column with the

reserved column <RowID> as that might/will cause follow up errors

• AP-22453: Update Packages in Bundled Python Environment

• AP-22452: Update Python version in Web Interaction Nodes to Python 3.10.14

• AP-21733: Don’t start executor in case the preferences can’t be fetched

• AP-21730: Change name of temp folder for Hub jobs

• AP-21704: Title of 5.1 Workflows Shown as "There has been no title set […]. " on KS

• AP-21680: Credential Flow Variable should show user name in string representation

• AP-21653: Investigate successful REST requests using then URLConnection while

connecting to authenticated Proxies

• AP-20676: Move KNIME-built Python extensions to internal update site

• AP-18422: Set up pipeline for automatic metapackage build + upload

• NXT-2531: Pixel based side panel

• NXT-2417: Prevent jobs from being swapped while interacting with job viewer

• NXT-2386: Replace legacy database port types with new db port types in component

input/output port list

• UIEXT-1611: Relax sanitization for Text Output Widget (legacy)

• AP-22426: Move new timeseries extension from community to labs

Bug Fixes

• AP-21471: DataType.getCommonSuperType() returns type of pm4knime (kudos to

@iankruger for reporting 1)

• AP-21669: The component output port gets activated in an inactive branch in case of

missing flow variable (kudos to @takbb @masgo for reporting 1 2)

• AP-21672: Broken Community Extension might break PortType#availablePortTypes

(should try-catch ExceptionInInitializationError) (kudos to @mwiegand @ajackson

@joel_lewinson for reporting 1 2 3)

• AP-21681: Node repository is empty after installing certain extensions (kudos to

@rfeigel @danielesser for reporting 1 2)
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• AP-21702: Report port deserialization may not respect original fragment order (kudos

to @njconnolly for reporting 1)

• AP-21720: String to Date&Time node: Improve error message (kudos to @PKRISH for

reporting 1)

• AP-21776: Joiner might complain about duplicate columns although there are none

(but col names matching '(#1)') (kudos to @weiclav for reporting 1)

• AP-21872: Reset All button doesn’t function properly for metanodes (kudos to

@Christopher41 for reporting 1)

• AP-21960: Excel Reader: data shifts to wrong columns if re-evaluate formulas option is

not checked (kudos to @Appear3044 @cinthy for reporting 1 2)

• AP-22294: Python Script node does not respect KNIME’s proxy settings (kudos to

@koeties for reporting 1)

• AP-22339: REST nodes fail when using a credentials flow variable for Digest

authentication (kudos to @tescnovonesis for reporting 1)

• NXT-1939: If Statistics view/computation is aborted, data in Table is no longer shown

(kudos to @DiaAzul for reporting 1)

• NXT-2123: Clicking/tapping really fast on a node can cause an issue (kudos to @takbb

for reporting 1)

• NXT-2240: Description in space explorer card overlaps the space card boundaries

(kudos to @mlauber71 for reporting 1)

• NXT-2607: MUI load error in case of open temp workflow in a different drive than

workspace’s drive (kudos to @mwiegand for reporting 1)

• UIEXT-1619: The preview of twin list column selection in WebUI dialogs includes wrong

columns (kudos to @mwiegand for reporting 1)

• UIEXT-1674: Error in console for column filter when is manual not selected (kudos to

@mwiegand for reporting 1)

• UIEXT-1900: View nodes do not work in metanodes if directly connected to inner

metanode output (kudos to @BPU for reporting 1)

• AP-21958: Using local update archive is not possible (kudos to @arushib30 for

reporting 1)

• AP-22412: Python View plot preview does not work (kudos to @JHVines for reporting 1)

• AP-22737: Excel Reader throws IllegalStateException when parsing is cancelled too

quickly (kudos to @locodust6 for reporting 1)

• NXT-2490: Modern UI doesn’t load in presence of outdated community extension

(kudos to @Ardilla @arief_rama for reporting 1 2)
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https://forum.knime.com/t/clicking-tapping-really-fast-on-a-node-can-cause-an-issue/76595
https://forum.knime.com/t/enhancement-visual-support-for-power-users/75440
https://forum.knime.com/t/new-ui-ui-throwing-error-if-workflow-outside-of-workspace-is-opened/78824
https://forum.knime.com/t/bug-column-filter-with-partial-regex-match-doesnt-filter/77088
https://forum.knime.com/t/opening-node-config-throws-cannot-read-properties-of-null-reading-scrolltop/77161
https://forum.knime.com/t/viewer-extensions-and-metanodes/78619
https://forum.knime.com/t/downloading-extensions-by-adding-local-update-sites-unhandled-event-loop-exception/76914
https://forum.knime.com/t/python-view-cefnodeview-error/78680
https://forum.knime.com/t/when-using-excelreader-in-a-loop-an-illegalstateexception-occurs-at-random-times/80177
https://forum.knime.com/t/knime-modern-ui-not-working-error-during-launching/77880
https://forum.knime.com/t/sorry-knime-ui-has-stopped-due-to-an-error/77887


• UIEXT-1493: JavaScript Views do not work with bundled chromium (kudos to

@USCHUKN1ME for reporting 1)

• AP-18133: Excel Reader does not correctly load sheet selection mode (kudos to @Geo

@sw1336 for reporting 1 2)

• AP-21237: macOS Sonoma: Splash screen is displayed upside down (kudos to @ssq

@mlauber71 for reporting 1 2)

• AP-22839: Email Reader (Labs): Network utilized but no task identifiable due to bad

progress report (kudos to @mwiegand for reporting 1)

• NXT-2211: "Save As" workflow not working properly (kudos to @sw1336 for reporting

1)

• AP-22413: AP-wide proxy does not use Eclipse proxy capabilities

• AP-22321: Updating nested linked components may fail in executor

• AP-22277: Proxy credentials not supplied for Workflow Jobs with HTTPS Connections

• AP-22103: Python Views don’t open after unsaved re-execute

• AP-22019: Can’t set execution retries when initially creating a schedule

• AP-22015: Credentials Configuration and Widget nodes no longer allow overriding

credentials with String variables

• AP-21997: Integrated deployment: workflow manager instance doesn’t retain custom

workflow name

• AP-21967: Authenticated proxy credentials are saved and reused KNIME-wide till restart

after the first use

• AP-21738: Missing Plotly extension leads to workflow/component error on load with

deleted node

• AP-22826: Google Authenticator does not always get a refreshable credential during

interactive login

• AP-22811: Global proxy settings in executor will break executor functionality

• AP-22803: Customization profile download doesn’t work with proxy configuration

• AP-22793: Environment bundling picks cuda version of packages if available

• AP-22749: Google Big Query Connector complains about wrong file extension when

using the OAuthPvtKeyPath JDBC parameter

• AP-22690: Call Workflow Service Node fails calling Service Deployments with "Use

current Hub " Hub Auth Connection

• AP-22667: KNIME Hub mountpoints are greyed-out if logged in as consumer (read-only

user)
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• AP-22664: Box Plot under some circumstances does not calculate the Q3 values

correctly

• AP-22558: Fix problem when escaping column placeholder in parameterized and

looping db nodes

• AP-22543: Google nodes do not use proxy settings

• AP-22522: Specific characters cause invalid SVG and failure to upload workflow to hub

• AP-22427: NodeLogger incorrectly handles OFF appender level

• AP-22411: Generic ECharts View cannot work with JSON columns

• AP-22397: ROWINDEX is always 0 in Math Formula when executed in Streaming mode

• AP-22320: Markdown documentation of auto-complete not styled correctly

• AP-22316: Duplicate Row Filter may fail with certain settings

• AP-22302: BufferedRowWrite#setFrom does not handle missing values and reads from

wrong offset

• AP-22230: Error when bulk-downloading items from KNIME Server (json and xml)

• AP-22199: DB Pivot and DB Row Filter: Escape single quote values

• AP-22178: Generic ECharts View Placeholder not centered if script evaluation fails

• AP-22152: ProxyManager initialisation deadlock on startup

• AP-22131: Node recommendations update fails over authenticated proxy also causing

proxy settings unreachable

• AP-22095: Proxy environment variable NO_PROXY is ignored

• AP-22094: Possible workflow load problem in "Microsoft Authenticator " when port is

connected to component output

• AP-22052: Redundant proxy authentication popups on AP startup

• AP-22017: REST Web Service nodes: Adding hub credentials port swaps port tooltips

• AP-21996: Shared component link cannot be changed to a Business Hub destination

• AP-21785: KNIME-wide proxy exclude list dominates REST client nodes

• AP-21777: Email Reader might run indefinitely if a message gets deleted during

processing

• AP-21764: Generic ECharts View "only 2500rows " notification doesn’t auto-dispose

after a while

• AP-21759: HTTP connections to URLs ignore proxy exclude list

• AP-21749: Credentials are saved in node dialog even after switching to other methods

for authentication
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• AP-21735: Missing node message duplicated for each missing node

• AP-21728: Text Embedder fails if the input table has missing and/or empty values

• AP-21718: Include Conda Packages of Bundled Python Environment by default

• AP-21650: Duplicate Row Filter: "Column name of row status " field should disappear

when removing duplicate rows

• AP-21622: Race condition when shutting down draining executor

• AP-21540: Email Reader node flags read emails as unread if the "Mark read emails as

read " option is disabled

• AP-21341: Web Interaction Browser does not use KNIME’s proxy settings

• AP-21251: Cannot change component link type when it is workflow-relative

• AP-21243: Components can be modified (e.g. node added) when downstream nodes

are executing

• AP-20970: REST Client nodes: Lose flow variable credentials configuration when

reconfigured

• AP-20878: AI Extension nodes fail on column name collisions

• AP-20516: "Model Reader" (and other readers) may leave temp files behind after use

(only for large, complex models such as XGBoost)

• AP-20299: Duration in Table View (classic & modern) sorted like strings

• AP-20045: (Old) Table View access node data one last time after data is discarded

(node reset), possibly causing confusing error logs

• AP-19420: Component in inactive branch stops workflow execution

• AP-11652: REST nodes Credentials Authentication can be overwritten to null

• NXT-2684: Casing of space items cannot be changed by "rename " in Modern UI on

Windows

• NXT-2542: Workflow-changed-events aren’t sent after a job has been swapped and

unswapped again

• NXT-2512: Dialog crashes AP when being closed and a 'window.alert' window was open

(5.3)

• NXT-2491: Yellow-Bar Component Projects do not Save Changes Back to Hub/Server in

MUI Hybrid Mode

• NXT-2419: Hidden metanodes aren’t hidden in Modern UI

• NXT-2295: Empty metanodes with input or output bars are not displaying the bars

• NXT-2289: Place nodes deletes all bendpoints and undo won’t recreate them
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• NXT-2260: Changes in annotations are lost if a users switch the tab and styles are lost

if you switch from one to another workflow annotation

• UIEXT-1985: HTML Writer does not make use of file picker

• UIEXT-1969: Multiple selection widget in combobox mode doesn’t trigger re-execution

• UIEXT-1966: Two combo boxes on the same interface result in selection issues

• UIEXT-1845: File Chooser Widget does not show files and empty folders

• UIEXT-1836: InvalidSettingsException when opening dialog for unconnected Column

Filter

• UIEXT-1795: Modifying displayed statistics settings in Statistics View dialog doesn’t

reset/refresh the preview

• UIEXT-1787: Allow missing values for excluded columns in twinlist

• UIEXT-1782: Line plot lines are ignored if not in view port

• UIEXT-1751: Wrong data type shown in table view

• UIEXT-1733: Textarea closes dialog on enter

• UIEXT-1691: Cannot save Report PDF in the HUB

• UIEXT-1620: File Upload Widget finishes too early

• UIEXT-366: Re-execution is way slower in AP then in WebPortal

Nodes changing in KNIME Analytics Platform 5.3.0

New nodes:

• Fluoric logP

• Fluorine pKa

• CometAdapter

• CruxAdapter

• FidoAdapter

• LuciphorAdapter

• MaRaClusterAdapter

• MSFraggerAdapter

• MSGFPlusAdapter

• MyriMatchAdapter
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• NovorAdapter

• OMSSAAdapter

• PercolatorAdapter

• Resampler

• SiriusAdapter

• XTandemAdapter

• Smartsheet Reader

• Smartsheet Writer

• hERG

• Credentials Properties Extractor

• Variable Filter

• Example Data Reader

• Row Filter

• Row Splitter

• Databricks Unity File System Connector

• Databricks Workspace Connector

• Email Sender (Labs)

• Salesforce Connector

• Create FileStore Port

• Report To Table

• Residual Analyzer (Labs)

• SARIMAX Learner (Labs)

• Autocorrelation Plot (Labs)

• SARIMAX Predictor (Labs)

• Differencer (Labs)

• SARIMA Predictor (Labs)

• Date&Time Aggregator (Labs)

• Date&Time Aligner (Labs)

• SARIMA Learner (Labs)

• Giskard Scanner
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• Google Ads Geo Targets (Labs)

• Google Ads Keyword Ideas (Labs)

• Google Ads Query (Labs)

• Google Ads Connector (Labs)

• Text Chunker

• KNIME Hub Chat Model Connector

• HF TEI Embeddings Connector

• OpenAI Chat Model Fine-Tuner

• Presidio Analyzer

• Presidio Anonymizer

• Presidio Deanonymizer

• RDKit Fingerprint Reader

• RDKit Fingerprint Writer

• RDKit Functional Group Filter

• RDKit Structure Normalizer

Nodes replaced, old nodes deprecated:

• Row Splitter (deprecated)

• Row Filter (deprecated)

• Salesforce Authentication (deprecated)

• Salesforce Authentication Extractor (deprecated)

• RDKit Fingerprint Reader (deprecated)

• RDKit Fingerprint Writer (deprecated)

• RDKit Functional Group Filter (deprecated)

• RDKit Structure Normalizer (deprecated)

Nodes declared legacy:

• Create H2O Sparkling Water Context (legacy)

• H2O to Spark (legacy)

• Spark to H2O (legacy)

Nodes renamed:
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• Regex Split → String Splitter (Regex)

• Round Double → Number Rounder

• Extract Date&Time Fields → Date&Time Part Extractor

• GPT4All Chat Model Connector → Local GPT4All Chat Model Connector

• Lasso Regression Learner (sklearn) → Sklearn Lasso Regression Learner (Labs)

• Gaussian Process Classification Learner (sklearn) → Sklearn Gaussian Process

Classification Learner (Labs)

• Regression Predictor (sklearn) → Sklearn Regression Predictor (Labs)

• Classification Predictor (sklearn) → Sklearn Classification Predictor (Labs)

• Partial Least Squares Regression Learner (sklearn) → Sklearn Partial Least Squares

Regression Learner (Labs)

• Gaussian Process Regression Learner (sklearn) → Sklearn Gaussian Process

Regression Learner (Labs)

• Web Interaction End → Web Interaction End (Labs)

• Web Interaction Start → Web Interaction Start (Labs)

• Text Sender → Text Sender (Labs)

• Content Retriever → Content Retriever (Labs)

• Selenium Recording Player → Selenium Recording Player (Labs)

• Clicker → Clicker (Labs)

• Navigator → Navigator (Labs)

Extensions changing in KNIME Analytics Platform 5.3.0

New extensions:

• Chem AI

• Smartsheet extension for KNIME

• KNIME Expressions

• KNIME Timeseries (Labs)

• KNIME Giskard Extension

• KNIME Nodes for Google Ads (Labs)

• KNIME Presidio Extension
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Extensions removed:

• KNIME Column Storage (based on Apache Parquet)

Extensions renamed:

• "KNIME Expressions" → "KNIME Column Expressions (Labs)"

• "KNIME HTML/PDF Writer" → "KNIME HTML/PDF Writer (legacy)"

• "KNIME Weka Data Mining Integration (3.6)" → "KNIME Weka Data Mining Integration

(3.6) (legacy)"

• "KNIME Weka Data Mining Integration" → KNIME Weka Data Mining Integration

(deprecated)"

• "KNIME AI Extension (Labs)" → "KNIME AI Extension"

Extensions moved:

• Time Series Extension - Moved from trusted to KNIME (Labs)

• KNIME Web Interaction - Moved from trusted to KNIME (Labs)

• KNIME Nodes for Scikit-Learn (sklearn) - Moved from trusted to KNIME (Labs)

Community Extensions

Partner Extensions

Extension Contributor Changes

ChemAxon/Infocom JChem

Extensions Feature

INFOCOM CORPORATION Available

ChemAxon/Infocom Marvin

Extensions Feature

INFOCOM CORPORATION Available

Schrödinger Extensions for

KNIME

Schrödinger LLC Available soon

LigandScout Extensions for

the KNIME Workbench

Inte:Ligand GmbH Available

MOE Extensions for KNIME Chemical Computing Group

ULC

Available
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Pharmacelera extensions Pharmacelera S.L. Available

Spotfire File Nodes TIBCO Spotfire Available

Symanto Brain Symanto Available

Market Simulation nodes Decision Ready, LLC Available

KNIME Connector for

SAP(KCS) Nodes

De Villiers Walton Ltd. Available soon

exorbyte extension exorbyte GmbH Available soon

Trusted Community / Open Source Extensions

Extension Status

Generic Workflow Nodes for KNIME Available

KNIME Groovy Scripting extension Available

KNIME HCS Tools Available

KNIME Python Scripting extension Available

KNIME R Scripting extension Available

Lhasa Available

RDKit Nodes Feature Available soon

Slack Integration Available

Continental Nodes for KNIME Available

Genentech Available

Geospatial Analytics Extension Available

Neo4J Available

Vernalis KNIME Nodes Available soon

KNIME Image Processing Available

KNIME-CDK Available
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Extension Status

AF Utility Nodes Available soon

OpenMS Available soon

KNIME AI Extension Moved to KNIME (Labs) since 5.3

Web Interaction Moved to KNIME (Labs) since 5.3

KNIME Nodes for Scikit-Learn (sklearn)

Algorithms

Moved to KNIME (Labs) since 5.3

Experimental Open Source Extensions / Experimental Community Extensions

Extension Changes

CIR KNIME Integration Available

KNIME Matlab Scripting extension Available

Process Mining Extension Available

Apprise Nodes Available

Erlwood KNIME Open Source Available

KNIME Shapefile Support Available

Indigo KNIME integration Available - Not working on macOS because

of a bug in Indigo

AI.Associates Signal Processing Available

Enalos Nodes for KNIME Available

Redfield BERT Nodes Available

Redfield NLP Nodes Available

3D-e-Chem KNIME nodes Available

FSK-Lab Available soon

Word2Vec Available soon
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Extension Changes

PIA Available

AIA Insights Bioactivity Predictor Available soon - New since 2023

Supplychain visualization node Available - New since 2023

BIM - Building Information Modelling

Extension for KNIME (IFC)

Available - New since 2023

Smartsheet extension Available - New since 2024

Redfield PST Nodes Available - New since 2024

Chem AI Extension Available - New since 2024

MMI Data Analytics Nodes Not available anymore since 5.2

OrientDB Not available anymore since 5.1
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